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Congratulations on your purchase of Finale 2011 for Windows! 
 
IMPORTANT: Read this document before you begin working with Finale 2011 and print a copy of it to keep with 
your Finale information.  
 
This file contains important information about Finale 2011 not included in the User Manual as well as information 
about converting older files into the new version's format. Please note that Finale 2011 files cannot be opened in 
previous versions of Finale. 
 
This document is organized by each version's changes; those of you already familiar with earlier versions may wish 
to read only the new information. The Read Me contains the following sections: 
 
Running Finale 2011 
New features in Finale 2011 
Fixes in Finale 2011 
 
You may also visit our web site, www.finalemusic.com for updated information about Finale and information on 
new releases.  
 

Running Finale 2011 
 
System Requirements 
Windows XP/Vista/7 32-bit (64-bit compatible). 600MB hard drive space required for software and user manual. 
 
DVD-ROM drive. 800x600 minimum monitor resolution. Minimum 512MB RAM (1GB or more recommended for 
optional use of Garritan and Tapspace (VST) sounds: more RAM = more available sounds.) An additional 2 GB 
hard drive space is required for all included VST sounds. 
 
Optional:   
MIDI interface. MIDI input and/or playback device. Printer. Scanner. Microphone required for use of MicNotator®. 
A soundcard (including Standard DirectSound, MME, or ASIO drivers) is required for playing the VST sounds in 
Windows. 
 
Additional VST instruments will perform best with faster processors and hard drives. 
 
Installing Finale 2011 
If any previous version of Finale has been installed on the machine, Finale 2011 recommends that you restart your 
computer and log on as System Administrator before installing. This will prevent erroneous font warnings. 
 
We recommend that you install Finale, and any other software, when logged in as System Administrator. 
 
If you encounter problems during installation, we recommend that you do the following: 
 
1. Turn off any programs running in the background. Virus detectors can often prevent Finale from installing  
 necessary files and updating the registry. Rest assured, your Finale CD does not contain any viruses. 
2. Press Ctrl-Alt-Delete, then click on Task Manager and then the the Process tab. In the Processes Tab, click 
 on "User Name" to sort the running programs by user ID name. This lists every process that is running on  
 the system. 
3. Under the User Name column, look at all of the processes ("Image Name") with your account name. Click  



 on each one, and then click "End Process" and select OK.  Do this for every process assigned to your name 
 except “taskmgr.exe”, “explorer.exe”, and “System Idle Process.” 
4. Close the Task Manager. 
5. Check your system tray (lower-right corner of the screen) to see if any programs are running. Right-click  
 each of these and choose Close - especially antivirus software, which does interfere with programs properly 
 installing. 
 
Authorizing Finale 2011 
The first time you launch Finale, you will be prompted to authorize. To authorize a single copy of Finale, click 
Authorize Now! to open the Authorization Wizard (or, from the Help Menu, choose Authorize Finale). Then follow 
the instructions to authorize your copy of Finale via the Internet, phone, or mail. If you choose not to authorize, you 
will be prompted to do so each time you launch Finale. If you do not register within thirty days, printing and saving 
are disabled until you choose to authorize. 
 
Note that the User/Authorization Codes are computer specific, and will only work on the given computer 
installation. Make sure that the Authorization Code is typed in using capital letters, and also verify that the correct 
serial number has been entered. Your copy of Finale can be authorized on two computers simultaneously, and, with 
an Internet connection, authorization can be moved from one computer to another at will. Simply choose 
Deauthorize Finale from the Help Menu to open up a free slot. Your copy of Finale can now be authorized on a 
different computer. When you Deauthorize, printing and saving are disabled until authorization has been restored. 
 
If you make a change to the computer (such as replacing the hard drive or motherboard, or installing a new operating 
system), then you will need to re-authorize the installation. If you have already installed and authorized twice, you 
will need to contact Customer Support online www.finalemusic.com/support.aspx at your serial number and the 
location ID for the specific installation in question. If the software is not "reminding" you to authorize when you run 
the program, then the registration/authorization has been successfully completed. 
 
Starting Finale 2011 - DLLs 
Most applications (including MakeMusic products) require a set of files, the Microsoft redistributables, in order to 
work successfully on your system. These redistributable files are normally already present on most systems and are 
not generally included in application setup/install scripts - doing so would add about 1.5 MB to the size of the 
package, and cause a longer installation process. More importantly, as these files are constantly updated by 
Microsoft and are operating-system specific, including these files in an application installer could result in incorrect 
files being added in your system and subsequent problems. 
  
In rare cases these files may be missing or out of date on your system. In this case an error will be reported when 
you start the program. Here are some examples of the errors that could be reported:  
If the files are missing...  
'The dynamic link library MSVCP60.DLL could not be found in the specified path...' 
or  
'The dynamic link library MSVCRT.DLL could not be found in the specified path...' 
If the files are out of date...  
'The OCXTS.EXE file is linked to missing export MFC42.DLL:6880.' 
 
If you see one of these messages, visit www.microsoft.com for more information regarding these files and how to 
restore them. 
  
Online User Manual 
For full documentation on how to use Finale 2011, see the User Manual. To access the User Manual, choose the 
Help menu, then User Manual. If you have an Internet connection, Finale opens the User Manual using your default 
browser and accesses the latest online content from MakeMusic’s servers. If you do not have an Internet connection, 
Finale automatically opens the local version of the User Manual that was installed on your hard drive along side 
Finale 2011. 
 
 
 



Vista and Exporting EPS Graphics 
Windows Vista uses a new True Type font format that is not compatible with Finale’s EPS export mechanism. As a 
result, Vista users will notice the "Include Fonts" check boxes have been removed in the Export Selection and 
Export Pages dialog boxes. Including fonts in exported EPS graphics is still fully supported in Windows XP. 
 
Folder Reorganization 
To accommodate the autonomy of each of a computer's multiple users, and to prevent permissions issues, Finale 
2011 installs its components to various locations on your hard drive depending on their function and required 
accessibility. See "Finale Installation Details" in the User Manual for more information. 
 
Update Groups and Brackets plug-in 
To accommodate the autonomy of each of a computer's multiple users, and to prevent permissions issues, Finale 
installs its components to various locations on your hard drive depending on their function and required 
accessibility. See “Finale Installation Details” in the User Manual for more information. 
 
Update Groups and Brackets plug-in 
The Update Groups and Brackets plug-in has been removed in favor of Finale's 2011’s updated staff group and 
bracket functionality. Groups are now assigned to measure regions and can always me modified on either a full 
document or system-by-system basis. See “Group Attributes dialog box” in the User Manual for details.  
 
Playing QuickTime Videos in Finale's Movie Window 
To play QuickTime videos in Finale for Windows, QuickTime (a free download at www.apple.com) must be 
installed on your computer. Movie files saved in Windows Media Player formats do not require QuickTime. 
 
Sharing Finale Documents Online with Finale Reader 
Finale Reader provides a free, reliable, easy way to view and playback Finale documents downloaded from the 
Internet. To open a Finale (MUS) file available at Finale Showcase, or another online resource, viewers now need to 
simply download the file to their local machine and then open it in Finale Reader. This means all Finale 2011 files 
posted on the Internet will be available for viewing on all machines. Finale Reader is available for download free of 
charge at www.finalemusic.com/reader.  
 
Contacting Customer Support 
For Finale support, visit www.finalemusic.com/support.aspx.  
 
Converting Finale 2010 (and earlier) documents into Finale 2011 documents 
Finale 2011 has a different file format than earlier versions, and converts older files to the new format when you 
open them in Finale 2011. Finale 2011 will open and convert older versions' documents, giving them the default title 
"UNTITLED.MUS." We recommend saving a newly converted document with a different name than the original 
file, keeping the older unconverted file as a backup. If you do want to save the file using the same name, choose 
Save As from the File menu. Finale displays the original file name, so you can click OK to rewrite over the old file. 
 
Running older versions of Finale 
Finale 2010 (and earlier versions) for Windows or Macintosh cannot open any standard Finale 2011 file. To open a 
Finale 2011 document in an earlier version, save the file in MusicXML format and then open the MusicXML file 
using the MusicXML Import plug-in. Finale for Windows includes the MusicXML importer back to version 2003, 
and then back to 2000 using software available separately. Finale for Macintosh supports MusicXML import back to 
version 2004 (OS X only) using software available separately. See www.recordare.com/finale.  

 
 
 
 
 



New Features in Finale 2011 
For complete information, see the "What's New" topic in the Finale 2011 User Manual.  
 

Hiding Empty Staves. Finale makes it easy to hide staves that don't contain music, in your whole score or 
selected regions.  

Auto-Showing Music. If you choose to hide empty staves in your score, and then subsequently move measures 
or add notes to the hidden staves, the appropriate notes and staves now automatically appear. 

Hiding Staves Containing Music. Finale makes it easy to hide staves that contain music. Need parts for an 
instrument that you don't want to appear in the score? Simply hide staves in the score.  

Moving Staves. It’s now incredibly easy to move staves. Want to increase the distance between staves? Click 
and drag. Your music updates automatically as you drag and you receive on-screen feedback about the distance 
between the staves and what staves will be impacted.  

Reordering Staves. Want to reorder staves and/or groups? Now it's easily done instantly in one place.  

Enhanced Groups and Brackets. We've simplified the process of editing group names and brackets, and to 
change groups and brackets for the whole score or just selected regions – and groups automatically adjust their 
measure ranges when measures are added or removed. It's also easy to show the full staff and group names for 
any system (very helpful when you're starting a new movement).  

Music containing Lyrics Looks Better – Automatically. The default music spacing of music with lyrics is 
more intelligent, and multiple verses of lyrics are better aligned. Lyrics and music space together more 
intelligently – the way an engraver would prefer.  

Word Extensions. In addition to better music spacing on melismatic passages, word extensions now 
automatically draw to the next rest. Should you choose to edit a word extension, your edits are permanently 
"locked down," and you can freely drag word extensions to subsequent systems.  

Intuitive Lyric Entry Interface. Lyric fonts, word extensions, and hyphens now instantly update as you enter 
and look exactly as they will print. Should you want to fine-tune, you're free to do so with improved handles, 
drag-select control, and visual feedback including lyric attachment lines. 

Lyrics window. Whether you are typing directly into the score or click-assigning, Finale's new Lyrics window 
accompanies you throughout your lyric entry process.  

Type Into Score and Auto Update. Finale 2011 makes it much easier to access multiple fonts within lyrics. 
Now you have access to a text menu when you're typing into score. This makes it easy to change fonts and sizes 
while you're typing, and your lyrics instantly appear just as they will print out. Similarly all word extensions 
always update automatically.  

Automatic Lyric Numbering. Finale can now automatically add verse numbers to your lyrics. 

Additional Music Education Worksheets. Finale 2011 includes more than 350 education worksheets and 
more than 400 music education flash cards found in previous versions of Finale, plus these additions:Dozens of 
Jazz Improvisation Worksheets: Finale files that playback with the free, downloadable Finale reader and offer 
tips to beginning improvisers AND include jazz rhythm section accompaniment.  

New worksheets covering concepts related to form and analysis.  

Dozens of Classroom Resources – popular public domain literature to be used in the classroom. Includes 
folk songs, traditional songs and all Bach inventions. 

A few new additions to the existing collection of music-themed puzzles and games.  

Finale AlphaNotes Font. Created for use with beginning music students, the FinaleAlphaNotes font places 
note names inside noteheads. In addition to note names, sharps, flats, and solfège syllables are also provided. 
Finale 2011 also automates the process of applying these new noteheads to any region of any piece.  

Finale Percussion Font. Many publishers use icons to represent standard percussion instruments in their 
scores. This font contains the most complete collection of percussion characters available. Also included are 



handbell symbols and many unique characters including castanets, sine waves, scribbles, and more. 

Finale Mallets Font. The Finale Mallets font includes icons to represent any variety of mallet usages, including 
the ability to create cross-mallet symbol. For example, you could use two of the zero-width mallet characters to 
indicate the performer should use a yarn mallet in the left hand and a hard mallet in the right hand.  

Apply Capo Chords. Easily add capo chords and fretboards to your arrangement using this new utility. 

Garritan Sounds. Finale now includes more than 375 Garritan sounds. New additions include bass trombone, 
brass section, children ahs, flute section, electronic drum kit, synth space voice, synth warm pad, and steel 
drums.   

New Aria Player with a new user interface, clearer controls, an integrated Ambiance reverb, and a powerful 
new ability to save Ensembles, allowing you to quickly load multiple sounds even when configuring the player 
manually.  

Change Percussion MIDI Maps mid-score. You can now assign a new Percussion MIDI Map to any point in 
a staff when multiple non-pitched percussion instruments are used.  

Improved Pickup Measures. Finale now automatically fills pickup measures with the appropriate rest 
duration.  

Quick Reference Guide. The included Quick Reference Guide shows you how to complete common tasks 
quickly and easily in Finale. With a graphic-rich presentation, you instantly see how to accomplish your goals 
without reading lengthy descriptions. 

For details on specific interface changes added since Finale 2010, see Finale 2011 Interface Changes in 
the User Manual. 

 
Fixes in Finale 2011 
 
Chord Symbols 

• Problems relating to missing chord symbols have been resolved. 
 
Enharmonics 

• Enharmonic Alterations are now retained when notes are moved to subsequent measures. 
• Equivalent enharmonic spellings are now recognized when reducing notes. 

 
Exercise Wizard 

• Selection problems on page 3 of the Exercise Wizard have been resolved. 
 
FinaleScript 

• Two copies of all documents are no longer printed when processing a folder.. 
 
Fonts 

• Data Check-Font Utilities now changes the font of measure numbers. 
 
Human Playback 

• Human Playback no longer causes unexpected controller CC11 data. 
• Errors regarding inserting keyswitches have been resolved.  
• Dynamics now play back properly with Garritan Sound Effects. 
• Interpretation of trill accidentals has been improved. 
• Additional instruments including harpsichord and accordion are now supported. 

 
HyperScribe 

• Finale no longer crashes during HyperScribe sessions when MIDI Thru is set to Off. 
 



Lyrics 
• Undo during Click Assignment no longer shifts focus away from the score. 
• Handles no longer become displaced when clearing manual positioning of syllables. 
• Finale no longer crashes when clearing all word extensions with the Delete key. 

 
Measures 

• The default horizontal position of measure numbers in documents without libraries has been restored to 0. 
• There is no longer an extra tab stop in the Left Barlines section. 

 
Page Layout 

• Extraneous pages are no longer created after copying notes with Automatic Page Layout enabled. 
 
Text 

• Measure-attached text blocks can now be reassigned after they have been created. 
• Special characters like hard spaces can now be copied using the Edit Text dialog box. 

 
ScoreMerger 

• ScoreMerger now handles pickup measures correctly. 
 
Setup Wizard 

• Creating a file with more than 8 non-pitched percussion instruments no longer causes a crash. 
 
Selection 

• Stack selection can no longer appear when not all staves are selected. 
 
SmartMusic Accompaniments 

• Non-General MIDI percussion sounds are no longer off-by-one when saved as a Solo .SMP file, permitting 
proper percussion playback.. 

 
Staves 

• Deleted staves are now removed from systems in parts with Hide Empty Staves applied. 
• Context-clicking a staff or group handle and then clicking outside the context menu no longer erroneously 

selects measures. 
• Deleting a staff no longer transfers highlighting to the staff below. 
• Staff handles can no longer be deselected while measures in the staff remain selected. 
• Distances in the Staff Usage and Respace Staves dialog boxes are now positive. 
• Staves beneath a staff being dragged no longer continue to move after the dragged staff is restrained by a 

page margin. 
• The staff order can no longer be changed in the Respace Staves dialog box. 
• Applying Music Spacing to a pickup measure when in the Staff Tool no longer opens the ‘partial measure’ 

warning.’ 
 
Ties 

• Changes made to one tie no longer affect all other ties on the same note. 
 
VST 

• VST settings are no longer lost while extracting parts. 
• VST plug-ins moved to the ‘Ignore’ list are no longer re-evaluated and moved back to the ‘Validated’ list 

after Finale is re-launched. 
 
Word Extensions 

• Problems related to word extension handles displaying properly have been resolved. 
 


